‘ AFFINITY

Photo 2
2,6.0.3089 (Beta) 2 ‘

=t

Abb. RC3 (release candidate), RC4 ist v2.6.0.3106

o

Das neue ,, minor” 2.6 Release steht bevor.

RC3. ,This is a potential release candidate, meaning that 2.6.0 will be released to the public
shortly, though it may end up being a slightly later build than this, depending on what is found in
this build.” (Patrick Connor)

Einstellungen (Betaphase): Shortcut: Strg-Beistrich (Mac OS: Command-Beistrich)

Einstellungen & Inhalte aus Verkaufsversionen kopieren

Abb. ,Beta Program” — Einstellung einer bereits installierten Version tibernehmen oder die
Anwendungseinstellungen riicksetzen



Machine Learning Models/Maschinelles Lernen

(ML)

Einstellungen

Allgemein

Maschinelles Lernen

Abb. MENU > Bearbeiten > Einstellungen (Strg-Beistrich)

Die Modelle werden auf den lokalen Rechner geladen. Der Speicherverbrauch der einzelnen
Modelle ist angegeben. Es wird keine Internetverbindung bendtigt — alle Vorgange finden am
eigenen Rechner statt und werden eben nicht zur Bearbeitung (‘oder zum Trainieren') ,versandt”.

Segmentierung 290 MB
Mit dem Modell fir die Segmentierung kann Photo prazise Pixelauswahlbereiche aus Installieren

Pixelebenen oder platzierten Bildem erstellen. Verwenden Sie hierzu das Werkzeug h
"Ohbjektauswahl®.

Hauptmotiv

Mit dem Modul fir Hauptmotive kann Photo das visuelle Hauptmotiv in einer Pixelebene Installieren
oder einem platzierten Bild leichter begreifen. Installieren Sie es zusammen mit dem
Modell far die Segmentierung, wird der Menibefehl "Motiv auswahlen” verfiigbar.

Abb. Installieren von , Segmentierung” und ,Hauptmotiv“



Segmentierung: Objektauswahl / Object Selection Tool

(290 MB, AFPho 2.6)

R
| Objektauswahl

Abb. Beispiel Segmentation



Segmentauswahl durch Positionieren der Maus

Maus Uber das Objekt fuhren, nach Erkennung (Umrandung) klicken. Prinzipiell kann vorher
geklickt werden.

E s = J':I ¥

Abb. Nach dem Klick

j'!'_:f' -
Abb. Erkannt

Abb. Mous over

Segmentauswahl durch Aufziehen eines Rechtecks.

A

Klickt man auf das erste Icon ,,Neu” beginnt eine neue Selektion,
alle Bisherigen werden verworfen.

Hinzufligen: Griinen Schraffur — mehrere Bereiche auswahlen
Subtrahieren: Rote Schraffur (3) — weitere Selektionen von der vorhandenen abziehen

T
.If

Kreuzen: Blaue Schraffur (4) — Uberlappende Teile von zwei oder mehr bereits
ausgewadhlten Bereichen

luiila



Mehrere Bereiche lassen sich so nacheinander wéahlen, dabei kdnnen beide Methoden —,,mouse
over” und das manuelle Eingrenzen (Click & Drag) — Anwendung finden.

Abb. Modus ,Hinzufligen

Per ,Verfeinern” lasst sich die Auswahl ggf. optimieren:
MENU > Auswahl > Kante verfeinern, Strg-Alt-R

»Mehrteilige Objekte”: Es werden Teile von Objekten mitselektiert, so der Algorithmus glaubt,
das andere Bildteile noch zur gewlinschten Selektion gehdéren.

Abb. Rote/Gelbe Bereich: Alt-Shift wahrend Click & Drag



Hauptmotiv/Select Subject

(72 MB, AFPho 2.6)

Es wird versucht das Hauptmotiv zu erraten. Damit die Funktion "Motiv auswahlen (ML)"
verfligbar ist, muss das Segmentierungsmodell bereits installiert sein, das mit
unterschiedlichsten Motiven trainiert wurde.

Maschinelles Lernen

Hauptmotiv 72 MB

Farbe

Abb. MENU > Bearbeiten > Einstellungen > Maschinelles Lernen: Hauptmotiv

MENU > Auswihlen > Motiv auswihlen

Oberste Ebene auswahlen

Unterste Ebene auswahlen

Motiv auswahlen

Farbbereich
Abb. Motiv auswahlen

Vorgabe hinzufiigen Zusammenlegen

. 0
Abb. Auswahl umkehren (Strg-Shift-1) und S/W




Strg-Enter bei aktiver Textbearbeitung beendet diese (,Bestdtigung”) und das
Auswahlwerkzeug ist wieder aktiv (gilt nun fir alle Affinity Programme).

Vergleiche Strg-Enter versus ESC-Taste bei Publisher.

Ab 2.6 sind besonders folgende Anderungen bzgl. der Auswahl zu beachten:

Standardisierung fiir alle Pixel-Auswahlwerkzeuge
(die rechte Maustaste zur Bearbeitung fallt unter Windows nun weg).

B.' . I Modus: I TR B [

Es gilt fir Markierungs- und Freihandwerkzeuge

Shift zum Hinzufiigen (1) zu einer bestehenden Selektion
Alt zum Subtrahieren (2) von einer bestehenden Selektion



Beispiel: Einen horizontalen oder vertikalen Bereich eingrenzen

Auswahlrahmen - Spalten

 Auswahlrahmen - Zeilen

Linke Maustaste halten und ziehen: Selektion einer ,Pixelzeile” (1).
Wird nun zusatzlich die Strg-Taste gehalten, wird ab der selektierten Zeile eine horizontale
Markierung aufgespannt.

F E F & i F F

Abl;. (1) Zeilenauswahl Abb. (2) Zeilenauswahl
Gleiches gilt fiir die Vertikale:
1 i |
| I
| !
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Abb. (1) Einen Bereich aufziehen

(2) Nun die Alt-Taste halten, den Start der Subtraktion per gehaltener linker Maustaste
bestimmen und nun gleichzeitig wieder Strg zusatzlich zur Alt-Taste halten,
um den Bereich aufziehen zu kénnen.

Shift wiirde zur aktuellen Markierung (a bis b) Bereiche hinzufligen.

a b C d e f
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Abb. Per Strg-Shift hinzugefligte Bereiche: c bis d und e bis f
Grafik: Ausschnitt aus dem Testbild ,Philips circle pattern”

(The Philips circle pattern (also referred to as the Philips pattern or PTV Circle pattern)

refers to a family of related electronically generated complex television station colour test

cards. https://en.wikipedia.org/wiki/Philips circle pattern)
https://de.wikipedia.org/wiki/Testbild
https://en.wikipedia.org/wiki/Test card


https://en.wikipedia.org/wiki/Test_card
https://de.wikipedia.org/wiki/Testbild
https://en.wikipedia.org/wiki/Philips_circle_pattern

Das Freihand-Tool verwendet nun die gehaltene Strg-Taste fiir einen Moduswechsel.

Abb. Freihand auf Polygon Wechsel durch halten von Strg

IM MODUS (1) Freihand wird temporar der ,,Polygonal“~-Modus aktiv
IM MODUS (2) Polygonal wird temporar der ,Magnetisch“-Modus aktiv
IM MODUS (3) Magnetisch wird temporar der ,Polygonal“-Modus aktiv

Abb. Modi

NB. Im Polygonalmodus kann Freihand (Klick und Drag) und Magnetisch (Strg halten und
Maustaste loslassen) verwendet werden.

NB. Um einen Kreis oder ein Quadrat aufzuziehen, ist somit auch nicht mehr die Shift-Taste,
sondern die Steuerungstaste Strg relevant.

Abb. Strg-Click und Drag

NB. Die Shift-Taste wird weiterhin bei Werkzeugen, die nicht die Auswahl betreffen eingesetzt!

' Rechteck

by

() Ellipse

O .-'-".I:ngehn-:lr:tes Rechteck
Abb. Ellipse: Durch halten von Strg wird ein Kreis aufgezogen



Bei Pinseln (B) gilt nun:

Strg+Alt (Command+Alt) halten und ein weiterer Linksklick wechselt jeweils die Modi:
Breite/Harte vs Rotation vs Form/Abstand. Eine Mausbewegung nach oben/unten, links/rechts
andert die Parameter der jeweiligen Einstellung.
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Abb. Pinseleinstellungen durch Klick bei gehaltenen Strg-Alt-Tasten
(Width/Hardness, Shape/Spacing, Rotation)

Pinsel sind nun je Kategorie per Namen auffindbar (immer noch nicht global):

Kandle Pinsel Stock

Konturbreite Optionen: Ez::i; i_- Magnetisch ausrichten:

<Unbenannt> [Gedndert] (80.1%)

Abb. Konturbreite (Designer), Rechtsklick auf Freiflache: Kontur erweitern (expand stroke) und
,Profil zurlicksetzten” (Reset)

EN https://affinity.help/designer2/en-US.Iproj/index.html?page=pages/Tools/tools lineWidth.html

DE https://affinity.help/designer2/de.lproj/index.html?page=pages/Tools/tools lineWidth.html


https://affinity.help/designer2/de.lproj/index.html?page=pages/Tools/tools_lineWidth.html
https://affinity.help/designer2/en-US.lproj/index.html?page=pages/Tools/tools_lineWidth.html

Masken

Ein Rechtsklick auf Masken bietet zusatzlich praktische Optionen , Maske leeren”/“Maske flllen®.
Der Umweg Uiber Kanale entfallt (gilt auch fiir Publisher/Designer).

ﬂ"' Hintergrund

om. * 4 Maske
m

Maske bearbeiten
Maske verfeinemn...
Maske freigeben
Maske leeren

Maske fillen

Maske umkehren

Abb. Rechtsklick auf eine Maske (fill/clear masks)



»Objekte” in Affinity
Die Handhabung von RAW- oder Bildebenen, sprich ,Objekten”, die nicht direkt als
Pixelinformation (gerastert) vorliegen werden nun im Bedarfsfall automatisch gerastert.

Beispiel: Plug-Ins lassen sich ohne vorhergehendes Rastern auf Bild- und RAW-Ebenen
anwenden. Bei Rastervorgangen wird eine Warnung ausgegeben.

Beispiel: Ebenen werden auch automatisch gerastert (zB. RAW und ,,Image“-Ebenen), so eine
Markierung vorhanden ist und deren Inhalt, nicht die Markierung selbst, mit gehaltener
Strg-Taste neu positioniert werden soll.

P —
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Abb. Normal wird die Auswahl verschoben. Strg halten: Der Inhalt wird verschoben.

Anmerkung: Wird ,V“ betatigt und nun mit gehaltener Shift-Taste verschoben,
erzeugt man Duplikate.

Ebenso wenn eine ,Bild“-Ebene gewahlt ist und ins ,,Develop“~-Modul gewechselt wird oder die
,Liquify Persona“/“Tone Mapping Persona” bei RAW-Bildern.

: Ebene rastern und Filter anwenden

. Ebene rastern und Filter anwenden

Abb. Assistenzeinstellung Anwenden von Filtern auf Nicht-Pixelebenen
"Applying filters to non-pixel layers". Die Funktion blockiert durch das
automatische Rastern nicht mehr



Weiters gilt, nun OHNE RASTERN:

Pinselwerkzeuge (B) angewandt auf eine Bild- oder RAW-Ebene: Es wird nicht gerastert, sondern
eine nicht-destruktive verschachtelte Pixelebene erstellt und erst hierauf gemalt.

Bei ,Loschen” (E) wird eine neue Maskierungsebene erstellt und diese zum Léschen nicht-
destruktiv herangezogen.

1age/RAW layer:  Add mask layer

Duplicate and rasterise

Abb. Assistenzeinstellungen

,There may be edge case scenarios I've missed (relating to how Image and RAW layers are
handled when performing various operations on them). The goal with the changes for those
layer types was to make operations on them seem more intuitive when coming from other image
editing software, i.e. they should behave more like Pixel layers whilst trying to retain their non-
destructive characteristics where possible.

That's why deleting with a selection or using the erase brush masks them by default, and
painting creates a new child layer and so on. Some operations aren't possible to achieve non-
destructively (e.g. entering Tone Mapping), so rasterisation has to occur with a notification.”
(James Ritson, 2024-12-19)



»Inpaint” funktioniert nun auch mit RAW-Dateien bzw. Layer, die kein Pixelmaterial enthalten.

Achtung: Ggf. wird aber ein Layer — so im Assistenten gesetzt in eine Pixelebene gewandelt, da
nur dann Inpaint funktioniert.

Abb. Assistenten-Information. MENU > Bearbeiten > Einstellung > Assistent

Auch Zusammenlegen und Reduzieren (Merge Down / Merge Selected) von Pixel-, Vektor-,
Maskierungs-, Anpassungs- oder Bildebenen wurde auf RAW-Dateien erweitert.
Da die RAW-Dateien dabei gerastert werden miissen, erscheint eine Warnung.

Der Inpainting Pinsel (Restaurieren) merken sich die Option zwischen Sitzungen/Dokumenten
bzgl. den Quell-Einstellungen der oberen Kontextleiste , Aktuelle Ebene und Aktuelle Ebene und
Darunter” (Current Layer / Current Layer & Below). Dies gilt auch fur das Tool ,,Flecken
entfernen” (Patch Tool)

Reparaturpinsel

2
i Fecken entfernen
o

Schiénheitsfehler entfermnen

R
<" Restaurieren k

Aktuelle Ebene

Aktuelle Ebene

Aktuelle Ebene 8B Darunter

Rote Augen komrigieren
Abb. Inpainting (Shortcut: J, ggf. mehrmals betétigen)

Flecken entfernen (Patch Tool)
DE https://affinity.help/photo2/de.lproi/index.htm|?page=pages/Tools/tools patch.html
EN https://affinity.help/photo2/English.lproj/index.html|?page=pages/Tools/tools patch.html


https://affinity.help/photo2/English.lproj/index.html?page=pages/Tools/tools_patch.html
https://affinity.help/photo2/de.lproj/index.html?page=pages/Tools/tools_patch.html

Bild- und RAW-Ebenen lassen mit ,, Ausgewdahlte Farbe markieren” (Select > Select Sampled
Colour) verwenden. Ebenso ,(Farb-)Bereichsauswahlen” (select reds/greens/blues, tonal ranges,
alpha ...) ohne Rastern zu missen.

Transparenzbereich
Ausgewshlte Farbe markieren...
k Farbbereich
VergraBern / Verkleinem... Tonwertbersich
Randscharfe... Transparenzbereich
Abb. MENU > Auswahl > Ausgewéhlte Farbe Abb. Farbbereich, Tonwertbereich,
markieren Transparenzbereich

Weitere Informationen:
EN https://affinity.help/photo2/en-US.Iproi/index.html|?page=pages/Selections/selections sampled.html

DE https://affinity.help/photo2/de.lproi/index.html|?page=pages/Selections/selections sampled.html

Der Shortcut Strg-T wird nun standardmaRig fiir , Live Perspective” definiert.

Meue Live-Filterebene Unscharfe
Scharfzeichnen

MNeue Maskierungsebene
Verzerren Weller...

MNeue leere Maskierungsebene
Rauschen Strudel...

Neue Montagenmaskierungsebene Farben

MNeue Live-Maskierungsebene gl
Ausleuchtung... Versatz...

Schatten / Lichter... Konvex / Konkav...
Loschen Backspace Objekthverzerrung...
Duplizieren Perspektive...

Verkniipft duplizieren Liquify...

Live-Projelktion

Auswahl duplizieren Strg+) Gitterverzerrung...

Abb. MENU > Ebene > Neue Live-Filterebene > Verzerren > Perspektive

DE https://affinity.help/photo2/de.lproi/index.htm|?page=pages/Tools/tools patch.html
EN https://affinity.help/photo2/en-US.lproij/index.html|?page=pages/Tools/tools patch.html


https://affinity.help/photo2/en-US.lproj/index.html?page=pages/Tools/tools_patch.html
https://affinity.help/photo2/de.lproj/index.html?page=pages/Tools/tools_patch.html
https://affinity.help/photo2/de.lproj/index.html?page=pages/Selections/selections_sampled.html
https://affinity.help/photo2/en-US.lproj/index.html?page=pages/Selections/selections_sampled.html

Die Makrofunktionalitdit kommt nun ohne Rastern aus, wenn Parameter durch Benutzerlnnen in
der Makro-Unterbrechung eingegeben werden.

Folgendes lasst sich ab v 2.6 nun in Makros aufzeichnen:

Abwarts maskieren k

Abwarts zusammenlegen

Sichtbare zusammenlegen

Abwarts maskieren (Layer > Mask to Below)
MENU > Ebene > Abwirts maskieren

Ebenso ein DPI-Wechsel bei ,,DokumentgréRe dndern” (Resize Document)
wird im Makro notiert

TIFF-Bilder: Nicht assoziierte Alpha-Information wird nun korrekt importiert, grundlegender

Support war bereits in V2.1 gegeben (Straight/unassociated alpha support war schon in V2
verfligbar)



Autoclose/ Linienstil (Linestyle)

Automatisch schliellen von Linienziigen.

Zeichenstift, Knotenwerkzeug (Pen/Node) — Shortcut: P Pen, N Node
Automatisch schlieBen: ~ Weichhert: 50%

Abb. Designer — Bleistift, Shortcut: N (Auto Close)

Aus  Die Kurve wird nie geschlossen

Nah Die Kurve wird geschlossen, wenn sich die Endpunkte einander ndahern
(,Hundeknochen“-Indikator wird weiterhin angezeigt/“Dog bone*).

Fern Ahnlich wie Nah, der Abstand kann jedoch gréRer sein

Immer Die Kurve wird immer geschlossen, der Abstand von Anfang/Ende ist irrelevant

y OFF ﬁg NEAR ALWAYS
ol e

el

Abb. Aus/Nah/Fern/Immer (OFF/NEAR/FAR/ALWAYS)
(kleiner Kreis und nahe Zoomstufe zur Veranschaulichung)

g kp‘ Zeichenstift

'y ;- Knotenwerkzeug y E‘:::—;\.é? b

F |

Abb. Automatisch schlieflen



Neue Optionen in allen Anwendungen: Das Icon fir Linienstil

24

Abb. Linienstil und/oder Fiillung verwenden P/N (Designer) P (Photo)
(Designer/Photo/Publisher)

._ﬂ: ,ﬂf Zeichenstft

A r F  Knotenwerkzeug

Gesetzte Parameter lassen sich direkt ein- und ausschalten.
NB. Das Panel ,Kontur“ (MENU > Fenster > Kontur) ist als eigenstidndiges Panel nur in Designer
verankert. In Photo ist es in der oberen Kontextmentuleiste.
C

) «  Keep selected
f

Use line style

)

Abb. Pencil Tool (N): Use line style. Kontureinstellungen flr Pinsel/Bleistift verwenden.
Rechts das Kontextmenii von Affinity Photo.



Kontur:

> [Gedr

D=3
L % |k

— b Y 100
— Gekrimmt
Eigenschaft —> Mit Spitzen

— Dreieck

Abb. Designer: Linienstil und Fillung angewahlt Abb. Linienstil mit ,, Ende-Pfeil”

Der Linienstil fur die Kontur ldsst sich also im ,Konturbedienfeld” festlegen (,,Stroke“-Panel).
Ist die neue Option aktiv, verwenden alle Formen/Linien diese vorgegebenen Attribute der
gesetzen Konturparameter. Um eine Form ohne Kontur zu zeichnen wird das Symbol einfach
deaktiviert. Um mit den vorigen Einstellungen fortzufahren, die Option erneut aktivieren.
Gleiches gilt wie bisher fiir die Fillung.

Anmerkung: Auch mit der herkdmmlichen Selektion (M) via Ebeneneffekte lassen sich Konturen
erzeugen, dabei sind die Daten keine Vektordaten, sondern Pixeldaten.

Ebenensffekte

MNormal

Volltonfarbd

EEy Ebeneneffekte
Abb. Beliebige Selektion aufziehen/zeichnen und fillen. Per Ebeneneffekte die Kontur erzeugen.



LINIENSTIL

Abb Demo-Video

Demo-Video: Konturen als Pixelgrafik, neues Icon ,Linienstil” fir Vektorgrafik

RGN A Ad aRU i EsaChalty/ 2 SSie tsy Zb ey anterny AUSWAZEPixel Rt PEad Kent
uiliconmBmyenstilsmpa)

Anmerkung: Bei nachtraglichem Verschieben von Pixelbereichen auf Ebenen, die eben
Ebeneneffekte besitzen, werden die Eigenschaften automatisch Gbertragen.

Abb. Verschieben der PIXEL-Auswahl mit gehaltener Strg-Taste


http://www.dma.ufg.ac.at/assets/26377/intern/AUSWv2_PixelkonturFXPfadkontur_Icon_Linienstil.mp4
http://www.dma.ufg.ac.at/assets/26377/intern/AUSWv2_PixelkonturFXPfadkontur_Icon_Linienstil.mp4

Weichheit (N fir Bleistift, P fiir Zeichenstift)

Weichheit: 100 %

£ P \Veichheit: 0% n
N P

Abb. Designer. Weichheit zwischen 0 und 100

Mehr oder weniger Knoten werden automatisch neu positionieren, hinzugefiigt oder entfernt.
Standard: 50 %

NB. Dies hat nichts mit dem Stabilisator in der Kontextsymbolleiste zu tun. Zum Testen der
Funktion ,Weichheit”, einfach die Stabilisator-Funktionen abschalten.

Zeichenstiftwerkzeug (P) — Handhabung von Kurven via Doppelklick auf Anfasser oder Knoten:
Kurvenpunkte: Wechsel von ,Glatt” auf ,,Spitz“ und umgekehrt
Anfasser: Loschen

| Aktion: 9, 13

Umwandeln:

Doppelklick .
&

,_ﬂ“ Zeichenstift

T
. ﬂ M Knotenwerizeug
Doppelklick ——
loschen *

* In Spitz umwandeln
- In Glatt umwandeln
Abb. Doppelklick Funktion Abb. Alternativ: Alt-Klick auf einzelne

Knoten bzw. Rechtsklick (auch fir
mehrere selektierte Knoten)



Fillung von Objekten

Nach dem Aufziehen von Objekten, lasst sich per gehaltener Alt-Taste das Pipettenwerkzeug
(Farbpipette/Color Picker) aktivieren, um eine Fullfarbe direkt auf das erstellte Objekt zu
Ubernehmen.

Abb. Aufziehen rotes Objekt. Alt-Taste gedrickt halten, und per Pipette die Farbe von blauem
Objekt Gibernehmen

»Colour Picker Auto Apply“ (Auto Apply (Colour Panel) Colour Picker to Selection):
Automatisch die geklickt Farbe auf Objekte (ibernehmen.

Rechteck  Fillung: Kontur:

Farbfelder  Farbe  Verauf F A

*)

RGE-Schieber : Farbpipette

Bisher wurde die gewahlte/geklickt Farbe nur in das runde Farbfeld ilbernommen, das fir die
Zuweisung extra noch einmal angeklickt werden musste. Nun wird die Farbe gleich auf
selektierte Objekte Ubertragen.

Wird die ALT-Taste gehalten, wird wie vorher die per Pipette gewahlte Farbe nur in das runde
Farbfeld Gibertragen.



RAW

Canon CR3 RAW-Dateien werden in v2.6 unterstitzt.

Nikon HE and HE* ((,,HE Stern“) Formate werden (iber eine eigene Nikon-Programmbibliothek
gelesen (RAW Formate loss-less, high efficiency*, high efficiency der Z-Serie).
Vergleiche Z9 RAW Encoding (Nikon HE* / HE / NRAW).

»Noch proprietarere” Formate (eigentlich Tico-RAW von intoPIX - ,TIny COdec”“) sollten
vermieden werden.

Zwar ist die DateigrofSe geringer, aber die Kompatibilitat Glber mehrere Programme hinweg nicht
unbedingt gegeben.

Choose a compression type for MEF (RAW) photographs. In descending order by the size of the files
produced, the options are: [Lossless compression], [High efficiency], and [High efficiency].

= [High efficiency*] produces pictures that compare favorably in quality to those produced by
[Lossless compression] and are higher in quality than those produced by [High efficiency].

https://onlinemanual.nikonimglib.com/z9/en/15 menu guide 02 09.html

Open Source Software wie DarkTable, RawTherapee, Iridient RawDeveloper etc. unterstiitzen das
Format derzeit nicht.

Anmerkung: REDCINE-X Pro unterstiitzt nach der Ubernahme der Fa. RED durch Nikon nun
N-RAW (Video, zB. Z8, Z9). N-RAW ist etwa halb so groR wie ProRes RAW.
Beispiel Setting Nikon Z9: 8.3K Video mit 60 fps bei 12-Bit N-RAW-Codec (8256 x 4644 Pixel)

CODEC |  DEPTH ‘ TONE
N-RAWW | 12-bit | N-Log

Abb. Nikon N-RAW Videoformat (based on Tico)
Windows https://www.red.com/download/redcine-x-pro-win
Mac OS https://www.red.com/download/redcine-x-pro-mac


https://www.red.com/download/redcine-x-pro-mac/
https://www.red.com/download/redcine-x-pro-win
https://onlinemanual.nikonimglib.com/z9/en/15_menu_guide_02_09.html

Lesefolge / Reading Order Panel

PDFs fir erleichterte Bedienung (zB. um die Vorlesereihenfolge bei Text in Sprachwandlung
korrekt einhalten zu kénnen).

MENU > Fenster > Lesereihenfolge (Window > Reading Order)

Lesefolge

v Navigator

Textobjekte (Rahmentexte, Grafiktexte, Formtexte, Pfadtexte) werden automatisch in die
Lesefolge aufgenommen.

Standardfolge ist von oben nach unten. Bei Objekten nebeneinander zusatzlich von links nach
rechts.

Anderung an der Reihung erfolgt per Drag & Drop.

Alle Artikel erweitern
‘1 ‘ AEEl Alle Artikel reduzieren

| Auswahl reduzieren

3

Ausschluss aus Lesefolge einfaus

Gruppe schlieBen

| o

]
L]
SchlieBen (o
9
0

=
L)
o

]




Eine rein interne Gruppierung (zur bessere Ubersicht) kann durch anlegen von Artikel folgen
(Add Article) — momentan nur eine Gruppierung der Lesefolge.

a

Lesefolge

LA <

v <Artikel>

—=
%)

@
@

o
A

—
(4.}

L

o

Abb. Drag & Drop der Seiten 1-6 auf einen neu erstellten Artikel (s. Icon)

Zum Objekt wechseln

Abb. ,Zum Objekt wechseln (Lesefolge)” / ,Go to Article”



Anmerkung: Alt-Tags fir Grafiken lassen sich in Publisher genauso hinterlegen, wobei sich der
Titel oder eine Bildbeschreibung iber XMP-Metadaten (XMP:Titel, XMP:Beschreibung,
XMP:Uberschrift) aus einer Image-Datei (auch je Sprache) (ibernehmen lieRen. Rein dekorative
Elemente erhalten ein eigenes Tag, damit Screen-Reader diese Uberspringen.

MENU > Fenster > Tags

= 0

XMP:Erweiterte Besck v

Deutsch (Deutschlane ~

Abb. Tags/ XMP:Erweiterte Beschreibung (DE)

Auch IptcdxmpCore:AltTextAccessibility or Iptc4xmpCore:ExtDescrAccessibility lassen sich nun
verwenden.

Die Daten werden in ,Tagged“-PDFs beim Export Gibernommen und sind zB. im PDF-Readern
ersichtlich, so die Maus Uber ein Bild gefiihrt wird.

Weitere Informationen:
DE https://affinity.help/publisher2/de.lproj/pages/Panels/tagsPanel.html
EN https://affinity.help/publisher2/en-US.Iproj/pages/Panels/tagsPanel.html


https://affinity.help/publisher2/en-US.lproj/pages/Panels/tagsPanel.html
https://affinity.help/publisher2/de.lproj/pages/Panels/tagsPanel.html

Preflight

Sind Textrahmen verknUipft, aber einige davon zusatzlich skaliert, wirft der Preflight aka
,Checkliste” eine Warnung aus. Durch die (ungewollte) Skalierung einzelner Textrahmen andert
sich auch die SchriftgréRe.

A\ Rahmen mit ungleichen Skalierungen im Textfluss
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Abb. ,,Mismatched scaling” - Rahmen mit ungleichen Skalierungen im Textfluss

Mochte man dahingehend nicht gewarnt werden, lasst sich die Option abschalten.
Checklistenprofil bearbeiten

ICC-Profile fiir PDF/X prifen Sucht nach ungleichen Textskalierungen in FlieBtext, die eventuell die Schnftgrife
auf unerwartete Weise verandemn.
Fehlende Glyphen
Warnungsstufe: Deaktiviert Warnung Fehler
Textmuster

Rechtschreibung

Benutzerkommentar

PDF-Transfer

Alt-Text en Checkliste

e 2 T gl Profil: <Custom >

Update fiir Datenzusammenfithrung

Uberpriifen: Niemals Export Live Profil bearbeiten

Abb. Checklisten-Einstellungen. Profil bearbeiten: Rahmentextskalierung (Preflight)

Weitere Informationen:
https://affinity.help/publisher2/de.lproi/pages/Publishing/preflight.html


https://affinity.help/publisher2/de.lproj/pages/Publishing/preflight.html

,Data Merge” kann nun QR-Code aus vorhandenen Feldern erzeugen.

Felder haben ISBN/Publisher-Eintrage (MENU > Verweise > Felder)

Publisher:
ISBN-10:
ISBN-13:

*  Dokumentstatistik

Weitere Informationen:
Felder (Fields Panel)

DE https://affinity.help/publisher2/de.lproi/pages/Advanced/fields.html

DE https://affinity.help/publisher2/de.lproj/index.html?page=pages/Panels/fieldsPanel.html

EN https://affinity.help/publisher2/en-US.Iproj/index.html?page=pages/Advanced/fields.html
EN https://affinity.help/publisher2/en-US.Iproj/index.html?page=pages/Panels/fieldsPanel.html


https://affinity.help/publisher2/en-US.lproj/index.html?page=pages/Panels/fieldsPanel.html
https://affinity.help/publisher2/en-US.lproj/index.html?page=pages/Advanced/fields.html
https://affinity.help/publisher2/de.lproj/index.html?page=pages/Panels/fieldsPanel.html
https://affinity.help/publisher2/de.lproj/pages/Advanced/fields.html
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